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1. Einführung
Sehr geehrte Kundin, sehr geehrter Kunde,
Vielen Dank für den Kauf dieses Produkts.
Dieses Produkt erfüllt die gesetzlichen nationalen und europäischen Anforderungen.
Um diesen Status zu erhalten und einen sicheren Betrieb zu gewährleisten, müssen Sie als Anwender diese 
Betriebsanleitung beachten!

 Diese Bedienungsanleitung ist Teil dieses Produkts. Sie enthält wichtige Hinweise zur Inbetriebnahme und 
Handhabung. Bedenken Sie dies auch, wenn Sie das Produkt an Dritte weitergeben. Bewahren Sie diese 
Bedienungsanleitung daher zu Nachschlagezwecken auf!

Bei technischen Fragen wenden Sie sich bitte an:
Deutschland: www.conrad.de
Österreich: www.conrad.at
Schweiz: www.conrad.ch

2. Symbol-Erklärungen
 Das Symbol mit dem Blitz im Dreieck wird verwendet, wenn Gefahr für Ihre Gesundheit besteht, z.B. durch 

elektrischen Schlag.

 Das Symbol mit dem Ausrufezeichen im Dreieck weist auf wichtige Informationen in dieser 
Bedienungsanleitung hin. Lesen Sie diese Informationen immer aufmerksam.

	 Das	Pfeilsymbol	weist	auf	besondere	Informationen	und	auf	Ratschläge	zur	Bedienung	hin.	

3. Bestimmungsgemäße Verwendung
Bei	diesem	Produkt	handelt	es	sich	um	ein	eigenständiges	Gerät,	das	mit	einem	wiederaufladbaren	Akku	betrieben	
wird. Es kann ein vergrößertes Bild über das eingebaute 3“ TFT-Display, einen Fernseher oder einen Computermonitor 
wiedergeben. Es eignet sich zur Untersuchung von festen Objekten wie Münzen, Briefmarken, Steinen, Insekten, 
Pflanzen,	Textilien,	Leiterplatten	usw.	Als	Lichtquelle	dienen	dimmbare	LED-Leuchten	und	die	mitgelieferte	Software	
ermöglicht dem Benutzer, das Mikroskop zu kalibrieren und die Größe von aufgenommenen Bildern zu messen. 
Das Gerät ist nur für den Innengebrauch geeignet. Nicht im Freien verwenden. Der Kontakt mit Feuchtigkeit, z. B. im 
Badezimmer, ist unbedingt zu vermeiden.
Aus Sicherheits- und Zulassungsgründen dürfen Sie dieses Produkt nicht umbauen und/oder verändern. Falls Sie 
das Produkt für andere als die zuvor genannten Zwecke verwenden, könnte das Produkt beschädigt werden. Darüber 
hinaus ist dies mit Gefahren, wie z. B. Kurzschluss, Brand, elektrischer Schlag usw. verbunden. Lesen Sie sich die 
Bedienungsanleitung	genau	durch	und	bewahren	Sie	diese	auf.	Reichen	Sie	das	Produkt	nur	zusammen	mit	der	
Bedienungsanleitung an dritte Personen weiter.
Alle	enthaltenen	Firmennamen	und	Produktbezeichnungen	sind	Warenzeichen	der	jeweiligen	Inhaber.	Alle	Rechte	vorbehalten.
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4. Lieferumfang
• Hauptgerät
• Netzteil
• Kalibrierlineal
• USB-Kabel
• Standfuß

• 4 GB Micro-SD Karte
• Handschlaufe
• AV-Kabel
• Li-Ionen-Akku
• Bedienungsanleitung

Aktuelle Bedienungsanleitungen            
Laden Sie aktuelle Bedienungsanleitungen über den Link www.conrad.com/downloads herunter 
oder	scannen	Sie	den	abgebildeten	QR-Code.	Befolgen	Sie	die	Anweisungen	auf	der	Webseite.

5. Eigenschaften und Funktionen
• 3“ TFT-LCD-Display
• 20 x – 500 x Vergrößerung
• 5 Megapixel Bildsensor (12 MP interpoliert)
• Foto und Videoaufnahme
• Unterstützung von microSD-Karten (max. 32 GB)
• Wiederaufladbarer	Lithium-Ionen-Akku
• Unterstützung für Plug-and-Play.
• PortableCapture Plus-Software

6. Systemvoraussetzung
• Betriebssystem: Windows® Vista/7/8/10, Mac OS 10.9-10.13
• CPU: Pentium 300 oder kompatibler AMD-Prozessor 
• 100 MB freier Festplattenspeicher
• 512	MB	RAM
• 24-Bit-Grafikkarte
• Freier USB 2.0-Anschluss
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7. Sicherheitsanweisungen
Lesen Sie die wichtigen Informationen und die Bedienungsanleitung sorgfältig durch und beachten 
Sie insbesondere die Sicherheitshinweise. Falls Sie die Sicherheitshinweise und Informationen für 
einen ordnungsgemäßen Gebrauch in dieser Bedienungsanleitung nicht beachten, haften wir nicht 
für möglicherweise daraus resultierende Verletzungen oder Sachschäden. Außerdem erlischt in 
solchen Fällen die Gewährleistung/Garantie.

a) Allgemein
• Das Produkt ist kein Spielzeug. Halten Sie es von Kindern und Haustieren fern.
• Lassen Sie das Verpackungsmaterial nicht achtlos liegen. Dieses könnte für Kinder zu einem gefährlichen 

Spielzeug werden.
• Schützen Sie das Produkt vor extremen Temperaturen, direkter Sonneneinstrahlung, starken Erschütterungen, 

hoher Luftfeuchtigkeit, Feuchtigkeit, brennbaren Gasen, Dampf und Lösungsmitteln.
• Setzen Sie das Produkt keiner mechanischen Beanspruchung aus.
• Wenn kein sicherer Betrieb mehr möglich ist, nehmen Sie das Produkt außer Betrieb und schützen Sie es vor 

unbeabsichtigter Verwendung. Der sichere Betrieb ist nicht mehr gewährleistet, wenn das Produkt:
 - sichtbare Schäden aufweist, 
 - nicht mehr ordnungsgemäß funktioniert 
 - über einen längeren Zeitraum unter ungünstigen Umgebungsbedingungen gelagert wurde oder 
 - erheblichen Transportbelastungen ausgesetzt wurde.

• Gehen Sie vorsichtig mit dem Produkt um. Stöße, Schläge oder sogar das Herunterfallen aus geringer Höhe 
können das Produkt beschädigen.

• Beachten Sie auch die Sicherheitshinweise und Bedienungsanleitungen der übrigen Geräte, an die das Produkt 
angeschlossen wird.

• Wenden Sie sich an einen Experten, wenn Sie Zweifel an der Funktion, Sicherheit oder in Bezug auf den Anschluss 
des Produkts haben.

• Wartung,	 Modifikationen	 und	 Reparaturen	 dürfen	 nur	 von	 einem	 Techniker	 oder	 einer	 autorisierten	
Reparaturwerkstatt	durchgeführt	werden.

• Sollten Sie noch Fragen haben, die in dieser Bedienungsanleitung nicht beantwortet werden, wenden Sie sich an 
unseren technischen Kundendienst oder an andere Fachleute.

• Achtung, LED-Licht:
 - Nicht direkt in das LED-Licht blicken!
 - Nicht direkt oder mit optischen Instrumenten in den Strahl sehen!

• In Schulen, Ausbildungsstätten, Hobby- oder Selbstbedienungswerkstätten muss der Umgang mit elektrischen 
Geräten durch geschultes Personal überwacht werden.

• Bei Betrieb in gewerblichen Einrichtungen sind die einschlägigen Unfallverhütungsvorschriften der 
Berufsgenossenschaften für elektrische Betriebsmittel zu beachten.
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b) Akku
• Achten Sie beim Einlegen des Akkus auf die richtige Polung.
• Entfernen Sie die Batterie / den Akku, wenn Sie das Gerät längere Zeit nicht verwenden, um Beschädigungen durch 

Auslaufen zu vermeiden. Auslaufende oder beschädigte Batterie / Akkus können bei Hautkontakt Säureverätzungen 
hervorrufen. Beim Umgang mit beschädigten Batterien / Akkus sollten Sie daher Schutzhandschuhe tragen.

• Bewahren	Sie	Batterie	/	Akkus	außerhalb	der	Reichweite	von	Kindern	auf.	Lassen	Sie	Batterie	/	Akkus	nicht	frei	
herumliegen, da diese von Kindern oder Haustieren verschluckt werden könnten.

• Akku dürfen nicht demontiert, kurzgeschlossen oder ins Feuer geworfen werden. Versuchen Sie niemals, nicht 
aufladbare	Batterie	aufzuladen.	Es	besteht	Explosionsgefahr!

• Laden Sie den Akku nicht über das Stromnetz auf, solange das Mikroskop an einem mit Strom versorgten USB 
2.0-Anschluss angeschlossen ist. Dies kann zur Überhitzung der Batterie führen.

c) Netzteil
• Die	Netzsteckdose	muss	sich	in	der	Nähe	des	Geräts	befinden	und	leicht	zugänglich	sein.
• Als	Spannungsquelle	darf	nur	das	beiliegende	Netzteil	verwendet	werden.
• Als	 Spannungsquelle	 für	 das	 Netzteil	 darf	 nur	 eine	 ordnungsgemäße	 Netzsteckdose	 des	 öffentlichen	

Versorgungsnetzes verwendet werden. Überprüfen Sie vor dem Einstecken des Netzteils, ob die auf dem Netzteil 
angegebene Spannung mit der Spannung Ihres Stromversorgungsunternehmens übereinstimmt.

• Netzteile dürfen nie mit nassen Händen ein- oder ausgesteckt werden.
• Ziehen Sie Netzteile nie an der Leitung aus der Steckdose, ziehen Sie sie immer nur an den dafür vorgesehenen 
Griffflächen	aus	der	Netzsteckdose.

• Stellen	Sie	sicher,	dass	beim	Aufstellen	das	Kabel	nicht	gequetscht,	geknickt	oder	durch	scharfe	Kanten	beschädigt	
wird.

• Verlegen Sie Kabel immer so, dass niemand über diese stolpern oder an ihnen hängen bleiben kann. Es besteht 
Verletzungsgefahr.

• Ziehen Sie aus Sicherheitsgründen bei einem Gewitter immer das Netzteil aus der Netzsteckdose.

d) Mikroskop
• Untersuchen Sie keine Objekte, die Temperaturen außerhalb des angegebenen Betriebstemperaturbereichs des 

Produkts aufweisen.
• Eine plötzliche Temperaturänderung kann dazu führen, dass sich im Inneren des Mikroskops Tau bildet, wie wenn 
Sie	im	kalten	Winter	einen	warmen	Raum	betreten.	Legen	Sie	es	in	eine	Handtasche	oder	eine	Plastiktüte,	um	
Temperaturänderungen zu verlangsamen.

• Richten	Sie	das	Objektiv	des	Mikroskops	nicht	 lange	auf	die	Sonne	oder	starkes	Licht.	Starkes	Licht	kann	die	
lichtempfindliche	Elektronik	beschädigen.

• Der	Standfuß	des	Mikroskops	kann	Spuren	auf	empfindlichen	Oberflächen	hinterlassen.
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e) Schutz vor Staub
• Staub	und	Ablagerungen	aus	der	Luft	können	zu	einer	Verschlechterung	der	Bildqualität	führen.	Halten	Sie	das	

Mikroskop von staubigen Umgebungen fern.
• Die Öffnung des Kameraobjektivs sollte immer entweder mit Staubschutzhauben o. ä. bedeckt werden. Geeignete 

Optionen sind z. B. Aluminiumfolie oder Plastikbeutel.
• Wenn dunkle Flecken oder ähnliche Partikel auf den digitalen Bildern zu sehen sind und diese sich nicht 
Probenplatte	befinden,	 ist	die	wahrscheinlichste	Ursache	dafür	eine	Partikelverunreinigung	auf	dem	Bildsensor	
oder	einer	zugeordneten	Filteroberfläche.	Die	Kameras	müssen	nach	den	Empfehlungen	des	Herstellers	immer	
mit größter Sorgfalt behandelt und vor Verschmutzung geschützt werden.

• Überprüfen Sie vor jedem Einsatz die Frontlinse des Objektivs auf Verschmutzung.

8. Bedienelemente
a) Symbole auf dem LCD-Display

x1.5

Bedien- taste Beschreibung

 / 
Standbild / Videomodus

Timermodus

Anzahl der aufgenommenen / noch möglichen Bilder (basierend auf der aktuellen 
Bildauflösung	und	der	Größe	der	microSD-Karte).

MicroSD-Karte eingesetzt

Aktuelle	Bildauflösung

Akkustand

x1.5 Digitale Zoomstufe
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b) Mikroskop

A1
A2

A3

A4

A6
A7

A8

A9

A10

A11

A12

A13

A14

A20

A21

A22

A23

A24

A16
A17

A18

A15

A5

A19

A1 LED-Lichtquelle
A2 Kameraobjektiv
A3 Stativhalterung
A4 microSD-Kartensteckplatz
A5 Batterieanzeige-LED
A6 Bildaufnahme-Taste
A7 Digitaler Zoom +/-
A8 Befestigungspunkt für die Trageschlaufe
A9 Feinfokussierrad
A10 Helligkeitseinstellung für die LED-Beleuchtung
A11 Batteriefach
A12 Display-Scharnier

A13 Lautsprecher
A14 Bedienelemente
A15 Mikrofon 
A16  5V/DC-Ladeanschluss
A17  USB 2.0 Mini-B
A18  AV-out (AV-Ausgang) für Fernseher
A19 3“ LCD -Display
A20 Wiedergabe/links
A21 Produkt EIN-/AUSSCHALTEN
A22 Farbmodus/hoch
A23 Menü für Einstellungen
A24 Nach unten

	 Die	 Gummifüße	 an	 der	 Unterseite	 des	 Mikroskops	 können	 Spuren	 auf	 empfindlichen	 Oberflächen	
hinterlassen.
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9. Einrichten des Mikroskops
a) Einlegen des Akkus

• Schieben Sie den Batteriefachdeckel ab und 
setzen Sie den Akku ein. 

• Achten Sie dabei auf die im Batteriefach (A11) 
abgebildete Polarität.

• Setzen Sie anschließend den Batteriefachdeckel 
wieder ein.

b) Laden des Akkus
 Laden Sie den Akku nicht über das Netzteil auf, während das Mikroskop an einen mit Strom versorgten 

USB 2.0-Anschluss angeschlossen ist. Dies kann zur Überhitzung der Batterie führen.

• Der Akku kann über ein USB-Kabel oder ein 
Netzteil aufgeladen werden.
 - Schließen Sie das mitgelieferte Ladekabel 

an den 5V / DC- Ladeanschluss (A16) an der 
Rückseite	 des	 Standfußes	 und	 das	 andere	
Ende an eine Steckdose an.

 - Oder schließen Sie das mitgelieferte USB-Kabel 
an den USB-Anschluss (A17)	auf	der	Rückseite	
der Standfußes und das andere Ende an den 
USB-Anschluss Ihres Computers an.

• Die Batterieanzeige-LED (A5) leuchtet rot, um 
anzuzeigen, dass der Akku geladen wird, und 
erlischt, wenn der Akku vollständig geladen ist. 

• Wenn es an der Zeit ist, den Akku wieder 
aufzuladen, erscheint in der unteren rechten 
Ecke des LCD-Displays das Symbol für 
niedrigen Batteriestand (A19).
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c) Einsetzen der microSD-Karte
 Drücken Sie die Karte nicht mit Gewalt in den microSD-Kartensteckplatz (A4), da dies das Mikroskop 

und die Speicherkarte beschädigen kann. Die microSD-Speicherkarte muss vor dem Gebrauch formatiert 
werden (siehe Abschnitt „11.c Allgemeines / SD-Karte formatieren“).

• Wenn Sie das Mikroskop verwenden möchten, ohne es 
an einen Computer anzuschließen, müssen Sie eine 
microSD-Karte einstecken.

• Trennen Sie das Mikroskop vom Strom und schalten Sie 
es aus.

• Stecken Sie die microSD-Karte wie unten gezeigt ein. 

 Siehe Abschnitt „12. Mit einem Computer verbinden“ für Informationen zum Anschließen des Mikroskops 
an einen Computer.

10. Betrieb
 Decken Sie das Mikroskop nicht ab, wenn es in Gebrauch ist.

a) Produkt EIN-/AUSSCHALTEN

• Klappen Sie das Display auf oder drücken Sie die Taste,  um das Mikroskop ein- oder auszuschalten.
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b) Halten des Mikroskops
• Halten Sie das Mikroskop in Ihrer rechten Hand und 

stellen Sie den Winkel des LCD-Displays (A19) so ein, 
dass er auf Ihre Blickrichtung ausgerichtet ist.

• Verwenden Sie Ihre linke Hand, um auf alle Steuerelemente 
zuzugreifen, die Sie mit Ihrem Daumen nicht erreichen 
können.

c) Scharfstellen des Mikroskops
• Richten	Sie	das	Objektiv	(A2) auf das Objekt und stellen Sie die Helligkeit der LED-Beleuchtung ein (A10).
• Verwenden Sie das Feinfokussierrad (A9), um das Bild scharf zu stellen.

 Es kann einige Augenblicke dauern, bis der Weißabgleich sich automatisch einstellt und das Bild scharf 
stellt.	Wenn	das	Objekt	zu	stark	reflektiert,	sollten	Sie	die	Helligkeit	der	LED-Beleuchtung	(A10) verringern 
oder die LED-Beleuchtung vollständig ausschalten.

d) Starke und geringe Vergrößerung
• Zentrieren Sie die Linse (A2) über dem Objekt.
• Starke Vergrößerung: Drehen Sie das Feinfokussierrad (A9) ganz nach links und dann langsam zurück, bis das 

Bild scharf gestellt ist.
• Geringe Vergrößerung: Drehen Sie das Feinfokussierrad (A9) ganz nach rechts und dann langsam zurück, bis das 

Bild scharf gestellt ist.

 Nachdem Sie das Feinfokussierrad (A9) ganz nach rechts oder links gedreht haben, dauert es einige 
Sekunden, bis sich das LED-Licht wieder gleichmäßig eingestellt hat.

e) Digitaler Zoom
• Stellen Sie zuerst das Objekt auf dem LCD-Display (A19) scharf.

• Vergrößern oder verkleinern Sie das Objekt, indem Sie den digitalen Zoom anpassen  (A7) .

f) Foto-/Videoaufnahme
• Drücken Sie,  um zwischen Foto- und Videomodus zu wechseln.

 - Das Symbol  auf dem LCD-Display (A19)	zeigt	an,	dass	Sie	sich	im	Fotomodus	befinden.
 - Das Symbol  auf dem LCD-Display (A19)	zeigt	an,	dass	Sie	sich	im	Videomodus	befinden.

• Drücken Sie die Aufnahmetaste  , um ein Foto zu machen oder um ein Video aufzunehmen. 

• Wenn Sie ein Video aufnehmen, drücken Sie die Aufnahmetaste  erneut, um die Aufnahme zu stoppen.

 Halten Sie Ihr Handgelenk mit der linken Hand fest, um Verwacklungen zu vermeiden.
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g) Foto-/Videovorschau
• Drücken Sie die Taste , um in den Wiedergabemodus zu gelangen.

• Drücken Sie  oder , um ein Foto oder Video zur Ansicht auszuwählen.

 - Das Symbol  auf dem LCD-Display (A19) zeigt an, dass es sich um ein Video handelt.
 - Das Symbol  auf dem LCD-Display (A19) zeigt an, dass es sich um ein Foto handelt.

• Drücken Sie OK, um ein Video abzuspielen.

h) Wiedergabeoptionen
• Drücken Sie die Taste , um in den Wiedergabemodus zu gelangen.

• Drücken Sie  oder , um ein Foto oder Video zur Ansicht auszuwählen.

• Drücken Sie , um in das Untermenü zu gelangen. Drücken Sie dann  oder  für weitere Optionen wie:
 - Löschen: Löscht das Bild.
 - Schützen: Sperrt ein oder alle Bilder, um zu verhindern, dass sie versehentlich gelöscht werden.
 - Diashow: Zeigt alle gespeicherten Fotos nacheinander an. Die Diashow endet, nachdem alle Fotos angezeigt 

wurden.
• Drücken Sie OK, um eine Option auszuwählen.

i) Farbmodi
• Wechseln Sie im Fotomodus zu den Farbmodi, indem Sie die Taste  zum Wechseln zwischen Farbe / Positiv / 

Negativ drücken.

 Sie können die Farbmodi für die Videoaufnahme nicht ändern.

11. Einstellungsmöglichkeiten im Mikroskopmenü
• Um auf die Foto- oder Videoeinstellungen zuzugreifen, drücken Sie zuerst , um einen Modus auszuwählen.

 - Das Symbol  auf dem LCD-Display (A19)	zeigt	an,	dass	Sie	sich	im	Fotomodus	befinden.
 - Das Symbol  auf dem LCD-Display (A19)	zeigt	an,	dass	Sie	sich	im	Videomodus	befinden.

• Drücken Sie , um auf die Einstellungen zuzugreifen.
• Drücken Sie , um zwischen Kamera und allgemeinen Einstellungen zu wechseln.

• Drücken Sie  oder , um nach oben oder unten zu scrollen. Drücken Sie OK, um eine Option auszuwählen.

• Drücken Sie , um die Einstellungen zu verlassen.
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a) Kamera
• Auflösung:	Einstellen	der	Bildauflösung.	Je	höher	die	Auflösung	ist,	desto	mehr	Speicherplatz	nimmt	jedes	Bild	in	

Anspruch.
• Zeitraffer: 

 - Bilder: Festlegen der Gesamtzahl der Bilder, die aufgenommen werden sollen.
 - Intervall: Festlegen des Zeitabstands zwischen den aufgenommenen Bildern (hh: mm: ss).

 - Drücken Sie , um die Einstellungen zu verlassen.

 - Die Zeitrafferaufnahme wird automatisch gestartet und das LCD-Display (A19) zeigt das Zeitraffer-Symbol  
an.

 - Die Zeitrafferaufnahme wird beendet, nachdem die festgelegte Gesamtzahl der Bilder aufgenommen wurde, 
indem Sie auf OK oder  drücken.

• Schärfe: Bildschärfeveränderung über die Software (scharf, normal, weich).

b) Video
• Auflösung:	Einstellen	der	Auflösung	(VGA	oder	QVGA)

c) Allgemein
• Sprache: Einstellen der Displaysprache.
• Energiesparmodus: Einstellen der automatische Abschaltzeit ein, wenn keine Tasten für (off, 5, 10, 15) Minuten 

gedrückt werden.
• Frequenz:	Einstellen	der	Flimmerfrequenz:	50	Hz	oder	60	Hz.
• Datumsstempel:

 - Gehen Sie zuerst zu „Datum/Uhrzeit“ und stellen Sie die aktuelle Uhrzeit und das Datum ein.
 - Wenn Sie Einstellungen in „Datum/Uhrzeit“ vornehmen, werden alle Ihre Foto- und Videoaufnahmen mit einem 

Datums- und Zeitstempel versehen.
• TV-Ausgang: Auswahl zwischen PAL oder NTSC
• Datum/Uhrzeit: Einstellen des aktuellen Datums und der Uhrzeit.
• SD-Karte formatieren: Löscht alle Bilder auf der SD-Karte/bereitet eine neue SD-Karte für die Verwendung vor.
• Sys.	Reset:	Stellt	alle	Einstellungen	auf	die	Werkseinstellungen	zurück.
• Version: Zeigt die installierte Firmware-Version an.
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12. Verbindung zu einem Computer herstellen
Mit	der	 im	Lieferumfang	befindlichen	Software	 „PortableCapture	Plus“	 können	Sie	eine	Vorschau	von	Bildern	auf	
Ihrem	Computer	anzeigen,	Ihr	Mikroskop	vollständig	steuern	und	vieles	mehr.	Weitere	Informationen	finden	Sie	im	
Abschnitt „PortableCapture Plus-Software“.

• Verbinden Sie ein Ende des mitgelieferten USB-Kabels mit dem USB-Anschluss (A17) an Ihrem Mikroskop und das 
andere Ende mit einem freien USB 2.0-Anschluss an Ihrem Computer.

• Drücken Sie die Taste , um das Mikroskop einzuschalten.

• Drücken Sie  oder  und wählen Sie PREVIEW ON COMPUTER (VORSCHAU AUF COMPUTER). Drücken 
Sie dann auf OK.

• Führen Sie die Software aus, indem Sie nach der Installation auf dem Desktop auf das Symbol „PortableCapture 
Plus“ klicken.

 Wenn Sie das Mikroskop über die Computer-Software steuern, werden die Hardwaretasten deaktiviert, da 
die meisten Funktionen über die Software „PortableCapture Plus“ verfügbar sind.
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13. Herunterladen und Installation der Software

a) Windows®-Installation

1. Rufen	Sie	die	URL-Adresse	www.conrad.com/downloads auf. 
2. Geben Sie dann die Artikelnummer 1713200 in das Suchfeld ein.
3. Wählen Sie die Datei zum Herunterladen aus.
4. Wählen Sie PortableCapture installieren aus, um die Software zu installieren, und befolgen Sie die Anweisun-

gen auf dem Bildschirm, um den Installationsvorgang abzuschließen.
5. Führen Sie die Software aus, indem Sie nach der Installation auf dem Desktop auf das Symbol „PortableCapture 

Plus“ klicken.
  Ändern Sie ggf. die Anzeigesprache, z. B. Options (Optionen) > Language (Sprache) > English 

(Englisch).

b) MacOS-Installation
1. Rufen	Sie	die	URL-Adresse	www.conrad.com/downloads auf. 
2. Geben Sie dann die Artikelnummer 1713200 in das Suchfeld ein.
3. Wählen Sie die Datei zum Herunterladen aus.
• Wählen Sie die Datei PortableCapture Plus.pkg aus.
• Befolgen Sie die Anweisungen auf dem Bildschirm, um den Installationsvorgang abzuschließen.
• Führen Sie die Software aus, indem Sie nach der Installation auf dem Desktop auf das Symbol „PortableCapture 

Plus“ klicken.
  Ändern Sie ggf. die Anzeigesprache, z. B. Options (Optionen) > Language (Sprache) > English 

(Englisch).
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c) Übersicht

B1
B2

B3

B4

B5

B6

B7

B1 Menüpunkte
 - File (Datei) > Photos (Fotos) / Videos Folder (Video-Ordner): Hier werden erfasste Bilder auf Ihrem Computer 

gespeichert.
 - Options (Optionen) > Resolution (Auflösung):	Ändern	der	Auflösung	der	aufgenommenen	Bilder
 - Options (Optionen) > Resolution (Auflösung): Ein-/Ausblenden des Datums-/Uhrzeitstempel auf einem Foto 

oder in einem Video
 - Options (Optionen) > Language (Sprache):	Einstellen	der	Sprache	für	die	Benutzeroberfläche
 - Options (Optionen) > XY Guide (XY-Hilfslinien): Hilfslinien anzeigen/ausblenden

B2 Shortcuts: Kamera / Video / Timer / Vollbild

 
Wechseln Sie in den Vollbildmodus oder beenden Sie ihn, indem Sie auf den Vorschaubereich doppelklicken oder 
das Vollbild-Symbol auswählen.

B3 X- und Y-Achsen-Hilfslinien
B4 Bildvorschaubereich
B5 Vergrößerungsinformationen
B6 Foto/Video-Registerkarte:	Wählen	Sie	eine	Registerkarte	aus,	um	gespeicherte	Fotos	oder	Videos	anzuzeigen.
B7 Fenster für gespeicherte Bilder (Miniaturansicht)

 - Aufgenommene Bilder/Videos werden als Miniaturansichten angezeigt.
 - Wenn Sie mit der Maus über eine Miniaturansicht fahren, wird das Bild im Vorschaubereich angezeigt (B4).
 - Klicken Sie mit der rechten Maustaste auf ein Bild, um weitere Optionen anzuzeigen, z. B. Open (Öffnen), Save 

as (Speichern unter), Copy (Kopieren), Delete (Löschen), Delete All (Alle löschen).
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d) Fotos aufnehmen 
• Positionieren Sie das Mikroskop so, dass sich das Kameraobjektiv (A2)	nahe	am	Objekt	befindet	und	auf	dieses	

zeigt.
• Während Sie den Bildvorschaubereich (B4) beobachten, stellen Sie das Bild mit dem Feinfokussierrad (A9) scharf.

• Um ein Bild aufzunehmen, wählen Sie das Kamera-Shortcut-Symbol .
• Die Fotos werden in File (Datei) > Photos Folder (Fotoordner) gespeichert.

 Aufgenommene Bilder werden als Miniaturansichten im Fenster für gespeicherte Bilder angezeigt (B7). 
Wenn Sie mit der Maus über eine Miniaturansicht fahren, wird das Bild im Vorschaubereich angezeigt (B4). 
Bilder	werden	im	JPG-Format	gespeichert.

e) Videos aufnehmen
• Positionieren Sie das Mikroskop so, dass sich das Kameraobjektiv (A2)	nahe	am	Objekt	befindet	und	auf	dieses	

zeigt.
• Während Sie den Bildvorschaubereich (B4) beobachten, stellen Sie das Bild mit dem Feinfokussierrad (A9) scharf.

• Um mit der Aufnahme zu beginnen, wählen Sie das Video-Shortcut-Symbol  aus. Das Symbol blinkt, um 
anzuzeigen, dass die Aufnahme gestartet wurde.

• Klicken Sie auf das blinkende Symbol, um die Aufzeichnung zu stoppen.
• Videos werden in File (Datei) > Videos Folder (Videoordner) gespeichert.

 Aufgenommene Videos werden als Miniaturansichten im Fenster für gespeicherte Bilder angezeigt (B7). 
Wenn Sie mit der Maus über eine Miniaturansicht fahren, wird das Bild im Vorschaubereich angezeigt (B4). 
Videos werden im AVI-Format gespeichert.

f) Foto- und Video-Timer

.

• Sie	können	einen	benutzerdefinierten	Start-	und	Stopptimer	für	die	Aufnahme	
von Fotos oder Videoaufnahmen einstellen.

• Wählen Sie das Timer-Shortcut-Symbol  aus und wählen Sie dann Photo 
(Foto) oder Video.

• Nehmen Sie die gewünschten Einstellungen vor.
• Wählen Sie Start aus, um mit der Aufnahme zu beginnen.

 Die Aufnahme stoppt, nachdem das Programm die Parameter 
durchlaufen hat oder wenn Sie Stop (Stopp) wählen, um den Timer 
zu beenden. Stellen Sie vor der Aufnahme sicher, dass Sie genügend 
Speicherplatz auf Ihrer Festplatte haben.

g) Bildmesswerkzeuge
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 Um die Genauigkeit der Messwerkzeuge sicherzustellen, kalibrieren Sie zuerst Ihr Mikroskop. Siehe 
Abschnitt „14“. Kalibrieren des Mikroskops“, um weitere Informationen dazu zu erhalten.

 Doppelklicken Sie auf ein Bild im Fenster für gespeicherte Bilder (B7),	um	die	Oberfläche	für	Bildmessung	
aufzurufen, und wählen Sie dann das Messsymbol  aus.

• Continuous Line Measurement (Kontinuierliche Linienmessung). 
Klicken und ziehen Sie von einem Punkt zum anderen.

• Continuous Line Measurement (Kontinuierliche Linienmessung). 
Klicken und ziehen Sie von einem Punkt zu mehreren Punkten.

• Radius Circle Measurement (Radiuskreismessung). Klicken und ziehen 
Sie,	um	den	Radius	zu	vergrößern.

• Diameter Circle Measurement (Durchmesserkreismessung). Klicken und 
ziehen Sie, um den Durchmesser zu vergrößern.

• Three Points Angle Measurement (Drei-Punkte-Winkelmessung). Klicken 
und ziehen Sie von einem Punkt zum anderen, messen Sie den Winkel, und 
klicken Sie dann mit der Maus, um loszulassen. 

h) Zeichnen und Text
 Doppelklicken Sie auf ein Bild im Fenster für gespeicherte Bilder(B7),	um	die	Oberfläche	für	Bildmarkierung/

Kommentare aufzurufen, und wählen Sie dann das Symbol  zum Zeichnen aus.
• Ein Dropdown-Menü mit verschiedenen Optionen wird angezeigt.

• In den Line Properties (Linieneigenschaften) können Line Width 
(Linienbreite) und Line Color (Linienfarbe) angepasst werden.

• Um die Textoptionen zu ändern, wählen Sie das Symbol  für Text aus.
• Ein Dropdown-Menü mit verschiedenen Optionen wie Schriftart und 

Textfarbe wird angezeigt.
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14. Kalibrieren des Mikroskops
• Fokussieren Sie das Mikroskop auf das Kalibrierungslineal.
• Drehen Sie das Feinfokussierrad (A3), bis das Bild scharf wird. 

• Stellen Sie die Linealposition so ein, dass das Bild auf 
die XY-Hilfslinien ausgerichtet ist.

 Doppelklicken Sie auf ein Bild im Fenster für gespeicherte Bilder (B7),	um	die	Oberfläche	für	Bildmessung	
aufzurufen, und wählen Sie dann das Symbol  zum Kalibrieren aus.

• Klicken und ziehen Sie, um Start- und Endpunkte über 
einen bekannten Wert zu wählen, z. B. 1 mm-Abschnitte 
auf dem Lineal.

• Wenn das Dialogfeld angezeigt wird, geben Sie den 
genauen Wert der Messprobe in das Feld Actual 
dimension (Tatsächliche Länge) ein. Die Software 
berechnet die Vergrößerung. 

• Drücken Sie zur Bestätigung auf OK. Der eingestellte 
Vergrößerungswert wird in der oberen rechten Ecke 
angezeigt.
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15. Verbindung mit einem Fernseher herstellen

Sie können Ihren Fernseher als großes Display zum Betrachten vergrößerter Objekte verwenden.
• Schließen Sie das mitgelieferte AV-Kabel an den AV-out (AV-Ausgang) (A18) am Mikroskop und das andere Ende 

an den Videoeingang Ihres Fernsehers an.
• Drücken Sie die Taste , um das Mikroskop einzuschalten.
• Drücken Sie  ,um zwischen Foto- und Videomodus zu wechseln.

 - Das Symbol  auf dem LCD-Display (A19)	zeigt	an,	dass	Sie	sich	im	Fotomodus	befinden.
 - Das Symbol  auf dem LCD-Display (A19)	zeigt	an,	dass	Sie	sich	im	Videomodus	befinden.

• Drücken Sie  , um auf die Mikroskopeinstellungen zuzugreifen.
• Drücken Sie  , um zu „Setup (Einrichtung)“ zu wechseln.

• Drücken Sie  oder  und wählen Sie „TV Out (TV-Ausgang)“ aus. Drücken Sie dann auf OK.

• Drücken Sie  oder  und wählen Sie „NTSC“ oder „PAL“ aus. Drücken Sie dann auf OK.

• Drücken Sie  , um die Mikroskopeinstellungen zu verlassen.
• Wählen Sie den entsprechenden Eingangskanal an Ihrem Fernseher.

	 Informationen	 darüber,	 wo	 Sie	 die	 Videoeingänge	 finden	 und	 wie	 Sie	 den	 Eingangskanal	 auswählen,	
finden	Sie	in	der	Bedienungsanleitung	Ihres	Fernsehgeräts.

Videoeingang am Fernseher

Videoausgang
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16. Bildsicherung (USB-Modus)
 Sie können Bilder direkt auf Ihrem Computer speichern, ohne die mitgelieferte Software zu verwenden.

• Verbinden Sie ein Ende des mitgelieferten USB-Kabels mit dem USB-Anschluss (A17) an Ihrem Mikroskop und das 
andere Ende mit einem freien USB 2.0-Anschluss an Ihrem Computer.

• Drücken Sie die Taste , um das Mikroskop einzuschalten.
• Wählen Sie aus dem Menü heraus UPLOAD IMAGES (BILDER HOCHLADEN) aus und drücken Sie dann auf OK. 

Das Mikroskop wird auf Ihrem Computer als externes USB-Speichergerät USBSTORAGE angezeigt.
• Wählen Sie den zutreffenden Laufwerksbuchstaben und gehen Sie zu den Ordnern Photo (Foto) oder VIDEO, um 

auf Ihre gespeicherten Bilder zuzugreifen.
• Kopieren Sie Bilder in den gewünschten Ordner auf Ihrem Computer.

17. Stativhalterung
 Verwenden Sie keine Gewalt, um das Stativ in die Halterung zu schrauben, da dies die Schraubenöffnung 

beschädigen könnte.

• Sie können die Stativhalterung (A3) verwenden, um ein Stativ am Mikroskop zu befestigen.
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18. Pflege und Reinigung
• Trennen	Sie	das	Produkt	vor	jeder	Reinigung	von	Ihrem	Computer.	Wenn	es	heiß	ist,	warten	Sie,	bis	es	abgekühlt	

ist.
• Verwenden	Sie	keine	aggressiven	Reinigungsmittel,	Alkohol	oder	andere	chemischen	Lösungsmittel,	da	diese	zu	

Schäden am Gehäuse und zu Fehlfunktionen führen können.
• Die LED-Beleuchtung ist nicht austauschbar.
• Vermeiden	 Sie	 es,	 die	 Linse	 mit	 irgendwelchen	 Stoffen	 zu	 berühren.	 Reinigen	 Sie	 die	 Linse	 regelmäßig	 mit	

niedrigerer Druckluft.
• Verwenden	Sie	zum	Reinigen	des	Produkts	ein	trockenes,	faserfreies	Tuch.

19. Entsorgung
a) Produkt

 Elektronische Geräte sind Wertstoffe und gehören nicht in den Hausmüll. Entsorgen Sie das Produkt 
am Ende seiner Lebensdauer gemäß den geltenden gesetzlichen Bestimmungen. Entnehmen Sie evtl. 
eingelegte Akkus und entsorgen Sie diese getrennt vom Produkt.

b) Akkus
	 Sie	 als	 Endverbraucher	 sind	 gesetzlich	 verpflichtet	 (Batterieverordnung),	 alle	 gebrauchten	 Akkus	

zurückzugeben. Eine Entsorgung über den Hausmüll ist untersagt.

 Schadstoffhaltige Akkus sind mit dem nebenstehenden Symbol gekennzeichnet, das auf das Verbot der 
Entsorgung über den Hausmüll hinweist. Die Bezeichnungen für das ausschlaggebende Schwermetall 
sind: Cd=Cadmium, Hg=Quecksilber, Pb=Blei (die Bezeichnung steht auf den Akkus z.B. unter dem links 
abgebildeten Mülltonnen-Symbol).

Ihre verbrauchten Akkus können Sie unentgeltlich bei den Sammelstellen Ihrer Gemeinde, unseren Filialen oder 
überall dort abgeben, wo Akkus verkauft werden!
Sie	erfüllen	damit	die	gesetzlichen	Verpflichtungen	und	leisten	Ihren	Beitrag	zum	Umweltschutz.
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20. Technische Daten
a) Mikroskop
Stromversorgung ..............................................	Li-Ion	3,7	V	/	1050	mAh	(wiederaufladbarer	Akku)	 

5 V / DC, 500 mA (USB 2.0)
Ladezeit des Akkus ...........................................ca. 5 Stunden (über Netzteil)
Akkulaufzeit ......................................................ca. 4 Stunden
Speicher ...........................................................MicroSD (max. 32 GB)
Anzeige .............................................................7,6 cm (3“) TFT, Seitenverhältnis 4:3
Bildsensor .........................................................5 MP
Videoauflösung .................................................VGA
Kameraauflösung ............................................. 12MP (4032x3024), 9M (3456 x 2592), 5MP (2560×1920),  

3MP (2048×1536), 1,3MP (1280×960)
Farbe ................................................................24-Bit	RGB
Fokusbereich ....................................................10 mm (manueller Fokus)
Vergrößerung ....................................................20 x bis 500 x
Flimmerfrequenz ...............................................50/60 Hz
Bildformat .........................................................JPG
Videoformat ......................................................AVI
Videobildrate .....................................................max. 30 fps
Weißabgleich  ...................................................Automat
Lichtquelle ........................................................8 x LED (weiß)
Betriebsbedingungen .............................................0 bis +70° C, 25 bis 50 % relative Luftfeuchtigkeit (nicht kondensierend)
Lagerbedingungen .................................................-5 bis +50 °C, 25 bis 50 % relative Luftfeuchtigkeit (nicht kondensierend)
Abmessungen (L x B x H) .................................130 x 103 x 29 mm
Gewicht .............................................................160 g (mit Akku)

b) Netzteil
Eingang ............................................................100 - 240 V/AC, 50/60 Hz
Ausgang ...........................................................5 V/DC, 1 A 

c) Software
Unterstützte Betriebssysteme ...........................Windows® Vista/7/8/10, Mac OS 10.9-10.13
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1. Introduction
Dear customer,
Thank you for purchasing this product.
This	product	complies	with	the	statutory	national	and	European	requirements.
To maintain this status and to ensure safe operation, you as the user must observe these operating instructions!

 These operating instructions are part of this product. They contain important notes on commissioning and 
handling. Also consider this if you pass on the product to any third party. Therefore, retain these operating 
instructions for reference!

If	there	are	any	technical	questions,	please	contact:
www.conrad.com/contact

2. Explanation of Symbols
 The symbol with the lightning in the triangle is used if there is a risk to your health, e.g. due to an electric 

shock.

 The symbol with the exclamation mark in the triangle is used to indicate important information in these 
operating instructions. Always read this information carefully.

 The arrow symbol indicates special information and advice on operation. 

3. Intended Use
This	product	is	a	standalone	device	powered	by	rechargeable	battery.	It	can	output	a	magnified	image	through	the	
built in 3” TFT display, television or a computer monitor. It is suitable for examining solid objects such as coins, stamps, 
rocks, insects, plants, textiles, circuit boards, etc. Dimmable LED lights provide brightness, and the bundled software 
allow the user to calibrate the microscope, and measure captured images. 
It is intended for indoor use only. Do not use it outdoors. Contact with moisture, e.g. in bathrooms, must be avoided 
under all circumstances.
For safety and approval purposes, you must not rebuild and/or modify this product. If you use the product for purposes 
other than those described above, the product may be damaged. In addition, improper use can result in short circuits, 
fires,	electric	 shocks	or	other	hazards.	Read	 the	 instructions	 carefully	 and	store	 them	 in	a	 safe	place.	Make	 this	
product available to third parties only together with its operating instructions.
All company names and product names are trademarks of their respective owners. All rights reserved.
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4. Delivery Content
• Main unit
• Power adaptor
• Calibration ruler
• USB cable
• Stand

• 4 GB MicroSD card
• Hand strap
• AV cable
• Li-ion battery
• Operating instructions

Up-to-Date Operating Instructions            
Download the latest operating instructions at www.conrad.com/downloads	or	scan	the	QR	code	
shown. Follow the instructions on the website.

5. Features and Functions
• 3 inch TFT type LCD panel
• 20x	-	500x	magnification
• 5 megapixel image sensor (12 M interpolated)
• Photo and video
• MicroSD card support (max. 32GB)
• Rechargeable	Lithium-ion	Battery
• Support for plug and play.
• PortableCapture Plus software

6. System Requirements
• OS: Windows® Vista/7/8/10, Mac OS 10.9-10.13
• CPU: Pentium 300 or compatible AMD Processor 
• 100 MB free hard disc space
• 512	MB	RAM
• 24-bit video card
• Available USB 2.0 port
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7. Safety Instructions
Read the important information and operating instructions carefully and especially observe the 
safety information. If you do not follow the safety instructions and information on proper handling, 
we assume no liability for any resulting personal injury or damage to property. Such cases will 
invalidate the warranty/guarantee.

a) General
• The device is not a toy. Keep it out of the reach of children and pets.
• Do not leave packaging material lying around carelessly. This may become dangerous playing material for children.
• Protect	 the	 device	 from	extreme	 temperatures,	 direct	 sunlight,	 strong	 jolts,	 high	 humidity,	moisture,	 flammable	

gases, steam and solvents.
• Do not place the product under any mechanical stress.
• If it is no longer possible to operate the product safely, take it out of operation and protect it from any accidental use. 

Safe operation can no longer be guaranteed if the product:
 - is visibly damaged, 
 - is no longer working properly, 
 - has been stored for extended periods in poor ambient conditions or 
 - has been subjected to any serious transport-related stresses.

• Please	handle	the	product	carefully.	Jolts,	impacts	or	a	fall	even	from	a	low	height	can	damage	the	product.
• Also observe the safety and operating instructions of any other devices which are connected to the product.
• Consult an expert when in doubt about the operation, safety or connection of the device.
• Maintenance,	modifications	and	repairs	must	only	be	completed	by	a	technician	or	an	authorised	repair	centre.
• If	you	have	questions	which	remain	unanswered	by	the	operating	instructions,	contact	our	technical	support	service	

or other technical personnel.
• Attention, LED light:

 - Do not look directly into the LED light!
 - Do not look into the beam directly or with optical instruments!

• In schools, training facilities, hobby or self-service workshops, handling of electrical devices must be monitored by 
trained personnel.

• When operating on commercial premises, the relevant accident prevention regulations of workers’ compensation 
boards	for	electrical	equipment	must	be	observed.

b) Rechargeable Battery
• Correct polarity must be observed while inserting the rechargeable battery.
• The rechargeable battery should be removed from the device if it is not used for a long period of time to avoid 

damage through leaking. Leaking or damaged rechargeable battery might cause acid burns when in contact with 
skin, therefore use suitable protective gloves to handle corrupted rechargeable battery.
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• Rechargeable	battery	must	be	kept	out	of	reach	of	children.	Do	not	leave	rechargeable	battery	lying	around,	as	
there is risk, that children or pets swallow them.

• Rechargeable	battery	must	not	be	dismantled,	short-circuited	or	thrown	into	fire.	Never	recharge	non-rechargeable	
battery. There is a risk of explosion!

• Do not charge the rechargeable battery via mains power supply while the microscope is connected to a powered 
USB 2.0 port. This may cause the battery to overheat.

c) Adaptor
• The mains outlet must be located near to the device and be easily accessible.
• As power supply, only use the supplied mains adaptor.
• Only connect the power adaptor to a normal mains socket connected to the public supply. Before plugging in the 

power adaptor, check whether the voltage stated on the power adaptor complies with the voltage of your electricity 
supplier.

• Never connect or disconnect power adaptors if your hands are wet.
• Never unplug the power adaptor from the mains socket by pulling on the cable; always use the grips on the plug.
• When setting up the product, make sure that the cable is not pinched, kinked or damaged by sharp edges.
• Always lay the cables so that nobody can trip over or become entangled in them. This poses a risk of injury.
• For safety reasons, disconnect the power adaptor from the mains socket during storms.

d) Microscope
• Do not examine objects with temperatures outside the given operating temperature range of the product.
• Sudden temperature change may form dew inside the microscope like entering a warm room in cold winter. Put it 

inside a handbag or plastic bag to slow down temperature changes.
• Do not point microscope lens towards the sun or strong light for a long time. Powerful light may damage the light 

sensitive electronics.
• The base of the microscope may leave marks on sensitive surfaces.

e) Protection Against Dust
• Dust	and	debris	 from	 the	air	 can	 lead	 to	deterioration	of	 image	quality.	Keep	 the	Microscope	away	 from	dusty	

environments.
• The opening of the camera lens should always be protected either with dust covers such. Suitable options include 

aluminium foil or plastic bags.
• If dark specks or similar in-focus artifacts are observed in digital images, and they are not in the specimen plane, 
their	 most	 likely	 cause	 is	 particulate	 contamination	 on	 the	 image	 sensor	 or	 an	 associated	 filter	 surface.	 The	
cameras always need to be handled with the utmost care and protected from dirt according to the manufacturer‘s 
recommendations.

• Before every critical use, check the front lens of the objective for dirt.
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8. Operating Elements
a) LCD Display Icons

x1.5

ICON DESCRIPTION

 / 
Still image / video mode

Timer mode

Images taken / remaining (based on current image resolution and MicroSD card size).

MicroSD inserted

Current image resolution

Battery level

x1.5 Digital zoom level
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b) Microscope

A1
A2

A3

A4

A6
A7

A8

A9

A10

A11

A12

A13

A14

A20

A21

A22

A23

A24

A16
A17

A18

A15

A5

A19

A1 LED light source
A2 Camera lens
A3 Tripod mount
A4 MicroSD card slot
A5 Battery indicator LED
A6 Image capture button
A7 Digital zoom +/-
A8 Wrist strap attachment point
A9 Fine focus dial
A10 LED brightness adjust
A11 Battery compartment
A12 Display panel hinge

A13 Speaker
A14 Control panel
A15 Microphone 
A16  5V/DC charging port
A17  USB 2.0 Mini-B
A18  AV-out television cable port
A19 3” LCD display
A20 Playback / left
A21 Power ON/OFF
A22 Colour mode / up
A23 Settings menu
A24 Down

 The rubber feet on the base of the microscope may leave marks on sensitive surfaces.
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9. Setting Up the Microscope
a) Insert Battery

• Slide the battery compartment cover off and 
insert the rechargeable battery. 

• Match polarity as shown in the battery 
compartment (A11).

• Replace	the	battery	compartment	cover.

b) Charge Battery
 Do not charge the battery via mains power supply while the microscope is connected to a powered  

USB 2.0 port. This may cause the battery to overheat.

• The battery will charge via USB cable or mains 
power supply.
 - Connect the supplied charging cable to the  

5V/DC charging port (A16) at the back of the 
base, and the other end to a power outlet.

 - Or connect the supplied USB cable to the 
USB port (A17) at the back of the base, 
and the other end to the USB port on your 
computer.

• The battery indicator LED (A5) will glow red to 
indicate that the battery is charging, and turn off 
when the battery is fully charged. 

• When it is time to recharge the battery, a low 
battery icon will show on the bottom right corner 
of the LCD display (A19).
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c) Insert MicroSD Card
 Do not force the card into the MicroSD card slot (A4) as this may damage microscope and the memory 

card. The MicroSD memory card must be formatted before use (see section 11.c General / Format SD).

• If you wish to use the microscope untethered to a 
computer, you must insert a MicroSD card.

• Disconnect and turn the microscope OFF.
• Insert the MicroSD card as shown below. 

 See section “12. Connect to Computer” for information about connecting the microscope to a computer.

10. Operation
 Do not cover the microscope when it is in use.

a) Power ON / OFF

• Flip the display panel open or press the power  button to turn the microscope ON or OFF.
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b) Holding the Microscope
• Hold the microscope in your right hand and adjust the 

angle of the LCD display panel (A19) so it is in line with 
your vision.

• Use your left hand to access any controls that cannot be 
reached with your thumb.

c) Focus the Microscope
• Direct the lens (A2) over the object and adjust the LED brightness (A10).
• Adjust	the	fine	focus	dial	(A9) to bring the image into sharp focus.

 It may take a few moments for the white balance to auto adjust and bring the image into focus. If there is 
too	much	reflection	from	the	object,	consider	lowering	the	LED	brightness	(A10) or turning it off completely.

d) High and Low Magnification
• Center the lens (A2) over the object.
• High	magnification:	Turn	the	fine	focus	dial	(A9) all the way to the left, then slowly dial back until the image comes 

into focus.
• Low	magnification:	Turn	the	fine	focus	dial	(A9)  all the way to the right, then slowly dial back until the image comes 

into focus.

	 After	turning	the	fine	focus	dial	(A9) all the way right or left, it will take a few seconds for the LED light 
balance to adjust.

e) Digital Zoom
• First bring the object into focus on the LCD display (A19).

• Zoom in or out of the object by adjusting the digital zoom  (A7).

f) Photo / Video Capture
• Press  to switch between photo and video modes

 - An  icon on the LCD display (A19) indicates that you are in Photo mode.
 - An  icon on the LCD display (A19) indicates that you are in Video mode.

• Press the image capture button  to take photo or begin recording video. 

• If recording a video, press the image capture button  again to stop recording.

 Hold your wrist with your left hand to help prevent camera shake.



36

g) Photo / Video Preview
• Press the  button to enter playback mode.

• Press  or  to select a photo or video for viewing.

 - An  icon on the LCD display (A19) indicates that it is a video.
 - An  icon on the LCD display (A19) indicates that it is a photo.

• Press OK to playback a video.

h) Playback Options
• Press the  button to enter playback mode.

• Press  or  to select a photo or video for viewing.

• Press  to enter the sub-menu, then press  or  for further options such as:
 - Delete: Deletes image.
 - Protect: Locks one or all images to prevent them from accidentally being deleted.
 - Slide Show: Cycles through all saved photos. The show ends after all photos have shown.

• Press OK to select.

i) Color Modes
• In photo mode , change color modes by pressing the  button to cycle between (colour / positive / negative).

 You cannot change color modes for video recording.

11. Microscope Menu Options
• To	access	photo	or	video	settings,	first	press	  to select a mode.

 - An  icon on the LCD display (A19) indicates that you are in Photo mode.
 - An  icon on the LCD display (A19) indicates that you are in Video mode.

• Press  to enter settings.
• Press  to switch between camera and general settings.

• Press  or  to select up or down, press OK to select an option.

• Press  to exit the settings.
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a) Camera
• Resolution:	Change	the	image	resolution.	The	higher	the	resolution	the	more	memory	space	each	image	takes.
• Time Lapse: 

 - Frames: Set the total number of images to be taken.
 - Interval: Set the interval between images taken (hh:mm:sec).

 - Press  to exit the settings.

 - Time lapse will automatically start and the LCD (A19) will show the time lapse icon .
 - Time	lapse	will	finish	after	the	total	number	of	images	have	been	taken,	by	pressing	OK, or pressing .

• Sharpness: Software sharpen the image (Hard, Normal, Soft).

b) Video
• Resolution:	Switch	resolution	(VGA	or	QVGA)

c) General
• Language: Set display language.
• Power Save: Set the auto shut off time if no keys are pressed (off, 5, 10, 15) minutes.
• Frequency:	Change	the	flicker	frequency	50	Hz	or	60	Hz.
• Date Stamp:

 - First go to “Date/Time” and set the current time and date.
 - Setting “Date/Time” will apply a date and time stamp to all your photo and video recordings.

• TV Out: Select between PAL or NTSC.
• Date/Time: Set the current date and time.
• Format SD: Erases all images on SD card / prepares new SD card for use.
• Sys.	Reset:	Restores	all	settings	to	factory	defaults.
• Version:	Indicates	the	installed	firmware	version.
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12. Connect to Computer
Using the bundled ”PortableCapture Plus” software, you can preview images on your computer, take full control of 
your microscope and more. See section “PortableCapture Plus Sofware” for further information.

• Connect one end of the supplied USB cable to the USB port (A17) on your microscope, and the other end to an 
available USB 2.0 port on your computer.

• Press the power  button to turn the microscope ON.

• Press  or  and select PREVIEW ON COMPUTER, then press OK.
• Run	the	software	by	clicking	the	PortableCapture Plus icon generated on the desktop after installation.

 When controlling the microscope through the computer sofware the hardware buttons will be disabled as 
most of functions are available through the “PortableCapture Plus” software.



39

13. Download and install software

a) Windows® Installation

1. Visit: www.conrad.com/downloads .
2. Enter item number 1713200 .
3. Select	the	file	for	download.
4. Select Install PortableCapture to install the software, then follow the on-screen instructions to complete the 

installation process.
5. Run	the	software	by	clicking	the	PortableCapture Plus icon generated on the desktop after installation.

 If needed change the display language e.g. Options > Language > English.

b) Mac OS Installation
1. Visit: www.conrad.com/downloads .
2. Enter item number 1713200.
3. Select	the	file	for	download.
4. Find the folder on the installation disc named Mac.
5. Select	the	file	PortableCapture Plus.pkg	file.
6. Follow the on screen instructions to complete the installation process.
7. Run	the	software	by	clicking	the	PortableCapture Plus icon generated on the desktop after installation.

 If needed change the display language e.g. Options > Language > English.
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c) Overview

B1
B2

B3

B4

B5

B6

B7

B1 Menu items
 - File > Photos / Videos Folder: Where captured images are stored on your computer.
 - Options > Resolution: Change image capture resolution.
 - Options > Date /Time: Show/hide the recorded date and time in photo or video.
 - Options > Language: Change user interface language.
 - Options > XY Guide: Show/hide guidelines.

B2 Shortcuts: Camera / Video / Timer / Full Screen.

 
Enter / exit full screen mode by double-clicking the preview area or selecting the full screen icon.

B3 X and Y axis guidelines.
B4 Image preview area.
B5 Magnification	information.
B6 Photo / Video tab: Select a tab to view saved Photos or Videos.
B7 Saved images window (thumbnail view).

 - Captured images / videos show up as thumbnails.
 - If you hover the mouse over a thumbnail, the image will show in the preview area (B4).
 - Right	mouse	click	an	image	for	further	options	such	as	Open, Save as, Copy, Delete, Delete All.
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d) Take Photo 
• Position the microscope so that the camera lens (A2) is close to and pointing at the object.
• While observing the image preview area (B4),	bring	the	image	into	focus	using	the	fine	focus	dial	(A9).

• To capture the image select the camera shortcut icon .
• Photos will be stored in File > Photos Folder.

 Captured images show as thumbnails in the saved images window (B7). If you hover the mouse over a 
thumbnail, the image will show in the preview area (B4).	Images	are	stored	in	the	JPG	format.

e) Record Videos
• Position the microscope so that the camera lens (A2) is close to and pointing at the object.
• While observing the image preview area (B4),	bring	the	image	into	focus	using	the	fine	focus	dial	(A9).

• To start recording select the Video shortcut icon .The	icon	will	flash	to	indicate	recording	has	started.
• Click	the	flashing	icon	to	stop	recording.
• Videos will be stored in File > Videos Folder.

 Captured videos show as thumbnails in the saved images window (B7). If you hover the mouse over a 
thumbnail, the image will show in the preview area (B4). Videos are stored in the AVI format.

f) Photo and Video Timer

.

• You can set a custom start and stop timer for capturing photos or recording 
video.

• Select the Timer shortcut , then choose Photo or Video.
• Set your desired parameters.
• Select Start, to begin recording.

	 Recording	will	stop	after	the	program	has	run	through	the	parameters,	
or if you select Stop to end the timer. Make sure you have enough 
memory space on your hard disc before recording.
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g) Image Measuring Tools
	 For	 measuring	 tools	 to	 be	 accurate,	 first	 calibrate	 your	 microscope.	 See	 section	 “14.	 Calibrating	 the	

Microscope” for information about how to do this.

 Double-click an image in the saved images window (B7) to enter the measurement interface, then select 
the measure  icon.

• Any Angle Line Measurement. Click and drag from one point to another.
• Continuous Line Measurement. Click and drag from one point to multiple 

points.
• Radius Circle Measurement. Click and drag to extend the radius.
• Diameter Circle Measurement. Click and drag to extend the diameter.
• Three Points Angle Measurement. Click and drag from one point to 

another, measure the angle, then click the mouse to release. 

h) Draw and Text
 Double-click an image in the saved images window (B7) to enter the Image Markup / Comment interface, 

then select the draw  icon.
• A dropdown menu will show with various options.

• Line Properties include Line Width and Line Color.

• To modify text options, select the text  icon.
• A dropdown menu will show with various options such as font selection and 

text color.
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14. Calibrating the Microscope
• Focus the microscope on the calibration ruler.
• Rotate	the	fine	focus	dial	(A3) until the picture becomes sharp. 

• Adjust the ruler position so the image is lined up 
square	with	the	XY	guide	lines.

 Double-click an image in the saved images window (B7) to enter the measurement interface, then select 
the calibration  icon.

• Click and drag to select start and end points across 
a known value e.g. 1 mm increment along the ruler.

• When the dialog box shows, enter the exact value of 
the measurement sample in the Actual dimension 
field.	The	software	will	calculate	the	magnification.	

• Select OK to	 confirm.	 The	 adjusted	 magnification	
value will show in the upper right corner.
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15. Connect to Television

You	can	use	your	television	screen	as	a	large	display	for	viewing	magnified	objects.
• Connect the supplied AV cable to the AV-out television cable port (A18) on the microscope, and the other end to 

the video input on your television.
• Press the power  button to turn the microscope ON.
• Press  to switch between photo or video modes.

 - An  icon on the LCD display (A19) indicates that you are in Photo mode.
 - An  icon on the LCD display (A19) indicates that you are in Video mode.

• Press  to enter the microscope settings.
• Press  to switch to “Setup”.

• Press  or  and select “TV Out”, then press OK.

• Press  or  and select “NTSC” or “PAL”, then press OK.

• Press  to exit the microscope settings.
• Select the appropriate input channel on your television.

	 Refer	to	your	television	operating	manual	for	information	about	where	to	locate	the	video	inputs,	and	how	
to select the input channel screen.

Video-in on TV monitor

Video-out
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16. Image Backup (USB Mode)
 You can save images directly to your computer without going through the bundled software.

• Connect one end of the supplied USB cable to the USB port (A17) on your microscope, and the other end to an 
available USB 2.0 port on your computer.

• Press the power  button to turn the microscope ON.
• From the menu select UPLOAD IMAGES, then press OK. The microscope will appear on your computer as an 

external USB storage device USBSTORAGE.
• Select the applicable drive letter and navigate to the folders named PHOTO or VIDEO to access your saved images.
• Copy images to the desired location on your computer.

17. Tripod Mount
 Do not use force to screw the tripod into the mount as this may damage the screw hole.

• You can use the tripod mount (A3) to mount a tripod to the microscope.
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18. Care and Cleaning
• Disconnect the product from your computer before each cleaning. If it is hot, wait for it to cool down.
• Do not use any aggressive cleaning agents, rubbing alcohol or other chemical solutions as they can cause damage 

to the housing and malfunctioning.
• The LED lights are not replaceable.
• Avoid touching the lens with any substance. Clean the lens periodically with low pressure compressed air.
• Clean	the	product	with	a	dry,	fibre-free	cloth.

19. Disposal
a) Product

 Electronic devices are recyclable waste and must not be disposed of in the household waste. At the end 
of	its	service	life,	dispose	of	the	product	in	accordance	with	applicable	regulatory	guidelines.	Remove	any	
inserted rechargeable batteries and dispose of them separately from the product.

b) Rechargeable Batteries
	 You	as	 the	end	user	are	 required	by	 law	(Battery	Ordinance)	 to	 return	all	used	 rechargeable	batteries.	

Disposing of them in the household waste is prohibited.

 Contaminated rechargeable batteries are labeled with this symbol to indicate that disposal in the domestic 
waste is forbidden. The designations for the heavy metals involved are: Cd = Cadmium, Hg = Mercury,  
Pb = Lead (name on (rechargeable) batteries, e.g. below the trash icon on the left).

Used rechargeable batteries can be returned to collection points in your municipality, our stores or wherever 
rechargeable batteries are sold.
You	thus	fulfill	your	statutory	obligations	and	contribute	to	the	protection	of	the	environment.
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20. Technical Data
a) Microscope
Power source .................................................... Li-Ion 3.7 V/1050 mAh (rechargeable battery) 

5 V/DC, 500 mA (USB 2.0)
Battery charge time ..........................................Approx. 5 hrs (via power adapter)
Battery life .........................................................Approx. 4 hrs
Memory .............................................................MicroSD (max. 32 GB)
Display ..............................................................7.6 cm (3”) TFT, 4:3 ratio
Image sensor ....................................................5 MP
Video resolution ................................................VGA
Camera resolution ............................................ 12M (4032 x 3024), 9M (3456 x 2592), 5M (2560 x 1920),  

3M (2048 x 1536),1.3M (1280 x 960)
Color .................................................................24-bit	RGB
Focus range ......................................................10 mm (manual focus)
Magnification ....................................................20x to 500x
Flicker-frequency ..............................................50/60 Hz
Image format ....................................................JPG
Video format .....................................................AVI
Video frame rate ...............................................Max. 30 fps
White balance ...................................................Automatic
Light source ......................................................8 x LED (white)
Operating conditions .........................................0 to +70 °C; 25 - 50 % relative humidity (non-condensing)
Storage conditions ............................................-5 to +50 °C; 25 - 50 % relative humidity (non-condensing)
Dimensions (L x W x H) ....................................130 x 103 x 29 mm
Weight ...............................................................160 g (with battery)

b) Power Adaptor
Input...................................................................100 - 240 V/AC, 50/60 Hz
Output ............................................................... 5 V/DC, 1 A 

c) Software
Supported operating systems ...........................Windows® Vista/7/8/10, Mac OS 10.9-10.13
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